How to Image the Sun

You look through your telescope eyepiece and there in front of you is the most wonderful sight, you know immediately you must capture this moment forever. Not only will this give you a lasting memory of the event but also it can become an important scientific record. Many times an amateur astronomer has been the first to discover a new event but even if it isn’t a rare event it is important to you. Being prepared and able to accurately record a flare or a prominence lift off for instance can be a very rewarding challenge and can become very valuable data when submitted to the various astronomical associations and data collection sites. Whether you become a serious imager for data submission or just want a personal record of daily solar activity it is important to have the right equipment to hand and to be able to get the most out of it.

Hardware

Deciding what camera to buy and use for solar imaging can be a baffling experience. Imaging the Sun requires a very different approach to deep sky astrophotography. Instead of needing to take very accurately tracked long exposures, the Sun requires millisecond exposures and therefore accurate tracking is not entirely necessarily. Another consideration is seeing conditions during the daytime. Unlike at night, the Sun is causing local heating of the ground and surrounding buildings, these air currents can change in fractions of a second. To overcome this, a camera is needed that can take very fast millisecond exposures and take a lot of them in a short burst. Taking more captures will increase the probability of getting one frame during clear seeing and if a camera can take a higher number of frames per second then the chances of getting this lucky one frame is increased further. The next consideration is whether to choose colour or monochrome. Most solar filters allow the viewer to see the Sun in a single very narrow wavelength of light. This is true for Hydrogen alpha (red) and Calcium II K (violet) filters, however even when viewing in white light it is common to use a narrowband green Continuum filter. If a colour camera is used for narrowband imaging then ultimately resolution will be lost. Colour CCD chips use a Bayer matrix where each square of 4 pixels has one blue, one red and two green. If imaging in Hydrogen alpha then only one pixel in 4 on the chip will be excited with light meaning the resolution will be reduced by a quarter. Therefore, using a monochrome camera will allow every pixel to be utilised increasing resolution and sensitivity. The next question is whether to record at 8 bit or 16 bit. When recording in monochrome (grayscale) it is desirable to record at 16 bit which is equal to 65,536 shades of gray; if using 8 bit then the image will only be recorded with a scale of 256 shades of gray. Using 16 bit increases the dynamic range of the resulting image. Finally the next choice is whether to use a CCD or a CMOS chip. Generally most solar imagers prefer CCD chips, this is because some CMOS chips can introduce a strange fixed pattern noise when the image is being sharpened after stacking. Also the dynamic range obtained from some CMOS chips can be generally lower than a CCD chip although the most recent CMOS chips on the market are very much improved particularly the Sony IMX174 CMOS chip which is fast becoming the solar imaging chip of choice. In conclusion the best camera for solar imaging would be a camera with a high frame rate capable of taking many frames together in a short video sequence, a monochrome CCD chip and capable of recording in 16 bit. This automatically concludes choosing a webcam type camera and not a DSLR. It is possible to image the Sun with a DSLR but it depends on the chip present in the camera and its software but it is still not as easy to achieve a good image as with a webcam. Table 1 lists a selection of good monochrome webcams used by solar imagers at the time of going to press. This will change as technology brings out better and more sensitive chips but
these cameras will always be available on the second hand market. By reading the good and bad points for each camera type will give a general understanding of how CCD, frames per second, sensitivity (for a quantum efficiency of 100%, one count equals one photon) and pixel size influences the quality of image with solar astrophotography. Everything hereafter will be described in the understanding that a monochrome webcam is being used.

Table 1. A selection of good monochrome webcams used by solar imagers at the time of going to press. Key to abbreviations: QE quantum efficiency; fps frames per second; NR Newton’s rings; Halpha Hydrogen alpha; Ca K Calcium II K; ms milliseconds; p/s power supply; FD full solar disc; SSD solid state drive.
Image capture (acquisition)

Many cameras come with their own acquisition control programs, however some are better than others and some are just plain terrible for astronomical purposes. It is entirely up to the user whether to use the software provided by the manufacturer or whether to use freeware such as the very popular FireCapture by Torsten Edelmann.

It is important to get to know and learn these programs and get the camera set up properly and working well before even taking the camera outside. It is always a good idea to spend some time setting up automatic directories to save your files to (so you don’t lose them) and make sure that the automatic time and date stamp is set to record within the file name, this will be important later when taking time lapse animations or for making note of when important events occur.

Once you have your camera working with your computer it is important to make sure that you have it set up within the telescope system for optimum performance. It is generally preferred to have the camera in the straight through position (with the exception of using a Herschel wedge). Depending on the quality of the diagonal this can reduce light levels considerably and thus exposure time will be increased. If exposure times are longer, then the chances of capturing the milliseconds of good seeing will be reduced and the more chance of smearing will occur on more of the frames.

The next problem to consider before you start is to make sure you can see your laptop screen clearly and the acquisition controls. This can be tricky when the Sun is very bright, so using a commercial laptop shade, a homemade cardboard box cover, an umbrella or even a sheet or towel over the top of the computer screen can be a great help. Being able to see the screen clearly helps enormously when trying to achieve good focus and setting the brightness and contrast correctly of the image to be acquired.

There are many variables when capturing an image depending on the camera, make, model, telescope set up and much more. What is described below should be used as a guide only and this will be a starting point from which to get a basic image but to optimise for a specific set up, further experimentation will be needed. Depending upon which wavelength of light is being used to capture the Sun will also introduce variables, so for ease of explanation hydrogen alpha will be used for the main explanation and anything specific to white light or Calcium II K will be described after.

To begin, get the Sun visible on the computer screen in live view of the acquisition software. Check that the right directory is set for saving files and that the correct file type for acquisition is checked (.ser for 16 bit or .avi for 8 bit) and open the histogram function. By collecting data in 16 bit will give a better dynamic range for post processing but will take up more space on the hard disc drive.

There are three different settings to be aware of at this point- gain, gamma and exposure. Gain is not necessarily needed in solar imaging as there should be adequate light although some double stack Hydrogen alpha systems can suffer from low light levels. It is best to set this at minimum to start with as the least gain used equates to least noise in the final image and thus the lower number of images needed to stack. However, if the light levels are too low it is advisable to raise the gain slightly to reduce exposure times. It is far better to have a faster shutter speed thus reduce motion blur with a higher gain, however this will introduce more noise into the final image. To overcome
this scenario, acquire more images so more can be stacked in the final image thus reducing the noise this way.

Gamma control is useful in several ways but must be used with caution. Lowering the gamma will increase surface contrast and this can be an extremely useful tool in helping to achieve good focus. However it is not generally recommended to use low gamma when capturing the image. When lowering the gamma observe how the histogram shifts to the left, this will decrease the dynamic range of the blacks and ultimately lead to clipping. When this happens data is lost forever and subtle solar details within darker regions will be lost e.g. umbral structures. Surface contrast can be replicated in post-processing if you wish for it later, but if the data is lost at point of capture it can never be recovered.

Increasing the gamma will decrease surface contrast but will reveal fainter structures e.g. prominence details. Again caution must be used if capturing at a high gamma. This has a side effect by shifting the histogram to right making the blacks less black and this fogging can cause some artefacts to appear in the final image when the video is processed through the stacking program. Like before, fine structures can be revealed later in post-processing and better results can be achieved without these artefacts being in the way. With gamma, moderation is the key, there is nothing wrong with using mild increases or decreases during capture and experimentation is recommended to finding what works best with your particular camera and set up. For white light imaging in general it is better to have the gamma slightly lower than neutral to enhance the granulation contrast which will aid the stacking software, for Calcium II K keep the gamma neutral or very lightly raised as the umbral detail is faint and easily can be lost altogether without caution.

Set the exposure level for surface details once gain and gamma is decided upon. Using the histogram make sure that it is around 80-90% filled, if it is over 100% then some parts of the image are over-exposed and will appear as a bright white patch containing no surface detail in the final image and structures will be lost. It is best to avoid this, but during a solar flare event it is impossible not to get a burned out region as the flare will always be off the histogram due to its huge intensity. This can add drama to the final image by showing how large and bright the flare was compared to the surrounding regions which are exposed correctly. To image prominences it may be necessary to completely over expose the solar surface to reveal the fine structures of the faint prominence.

Once the live view is set to optimum spend a good deal of time trying to get good focus. An out of focus image will never be any good however much post processing is done. Wait until the seeing settles before trying to focus and be patient. Once happy with focus there comes the question of when to record and for how long. Record when the seeing is at its best, sit and wait patiently and be ready hit the record button during these times. Alternatively if you have the hard drive space available set FireCapture to auto record a series of image files of a specified length for a period of time. After stacking select the best file for post-processing. How long each video file should be depends upon many variables. It is all a question of chance, capturing a greater number of images gives a greater chance of having enough good quality frames to stack. The more good quality frames which are finally stacked will equal less noise in the final image and will allow more final sharpening to be applied. However if seeing is bad then using a greater numbers of frames which are of poor quality will result in a lower quality image as more blurred images will be included in the stack. By capturing too many images this will take a long time and by taking too long, the surface features of
the Sun will have changed considerably inducing motion blur to the final image. On average it is best to keep the file capture to no more than around a minute in duration by acquiring files of around 1000 images in size, if the seeing is poor increase this a little further.

Figure 1. Taking a flat field image using a plastic bag. This will defocus the image whilst retaining any defects such as uneven illumination, dust particles or Newton’s rings. For the flat field image record a video file with a matched histogram to the original image without the bag. This image can be used with the stacking program to extract out the defects from the image.

Another important file to acquire during your imaging session is to take a flat field particularly when imaging in Hydrogen alpha. This is because many cameras can suffer from mild to bad Newton’s rings or specks of dust can become lodged on the camera chip. The easiest way to do this is to get a very thin polythene bag from the fruit department of your local supermarket and cover the front of the telescope (Figure 1). Raise the gain and exposure to match the histogram that was originally used to image the Sun. It doesn’t matter if it is very high gain or exposure level as long as the histogram is matched. Take around 200 images and use this to create the master flat later. A new flat will need to be created for each magnification step that is imaged at. Some trial and error in finding the best method to capture the flat will need to be found. Some find a bag shown in Figure 1 to be too opaque, this can be rectified using cling film which is more transparent. Others find that simply defocusing the image and acquiring the flat field works best but only if taken on the central part of the disc.
Stacking

Once a series of avi or ser video files have been acquired they need to be processed in such a way as to give a single resulting image composed of the very best frames from the file but stacked together. The three main programs available for free are AutoStakkert!3 by Emil Kraaikamp, RegiStax 5 and 6 (depending on which version you prefer) by Cor Berrevoets and AviStack 2 by Michael Theusner. Each is available with tutorials for guidance and help on the appropriate website. Generally the most popular program used for solar work and ultimately giving the best overall quality in fine surface detail is AutoStakkert!3. However it is generally felt that RegiStax 6 can give better prominence and limb detail separation. AviStack 2 is a good all-rounder but very slow.

Figure 2. AutoStakkert!2, showing the left window with 1) Open, 2) Analyse, Stack options and 3) Stack. The right window pane contains the AP (alignment point) selections.

First, begin by creating the flat field. Open AutoStakkert!3 and load the flat field video file by clicking on 1) Open (Figure 2). On the menu bar click ‘image calibration’ and ‘create master flat’. Once this has been created open all the files you wish to process (1 Open), then return to the menu bar and this time click ‘load master flat’ and select the flat that was just created. Under ‘Image stabilization’ check the ‘surface tab’ and then click 2) Analyse. After a few minutes the program will stop and allow you to pick your stacking options. Either choose to stack a specific number of frames for example 10, 50, 100 of the best or use percentages instead. By choosing a few different values the program will process the file once but then finalise by stacking the different amounts of images shown in the boxes. This will save time by running the stacking program once but giving the user several stacked images, allowing the best quality image for sharpening and post-processing to be chosen later. Generally the lower the number of frames which are stacked the more noise will be present in the final image and the less sharpening can be done later in post-processing. On the other hand, the more images that are in the final stack can give lower noise but the likelihood of more bad frames creeping into the stack will leave the final image less sharp. A happy medium needs to be found but typically around 10% of 1000 frames on average will give a good result, but this can change with seeing conditions, so picking a range to choose from later is easier. Finally, on the image pane window (right) choose an alignment point (AP) size. Generally the smaller the better for
finer detail however this has a trade off by taking longer to process. Then click 3) Stack and wait for the software to complete the files.

**Sharpening**

Sharpening the stacked image can be achieved by many different techniques. One of the common ways to do this is by using the ‘wavelet’ functions in RegiStax. However, these wavelets are very difficult to master and use properly. They can easily let the user end up with artificial and over-sharpened imaged. Unless you have a deep understanding on how to use these functions in the correct way they are best avoided. By far the simplest and safest method for sharpening is using the free ImPPG tool created by Filip Szczerek. This uses Lucy Richard deconvolution and the Sigma slider can be finely tuned to estimate the point spread function of the particular image and the results can be seen quickly. It is possible to save processing settings but as seeing conditions vary a lot between captures it is rare to have two images that need exactly the same settings. Begin by opening a stacked image in ImPPG (Figure 3) and click and draw a small square over an area in the image with a prominent feature, for example a sunspot region. Change the number of iterations to 500 and check the ‘Prevent ringing’ box. Then carefully move the Sigma slider in small amounts and wait for the selected box to show the results of the sharpening. This must be done with caution; the Sun is a large ball of flowing plasma and does not feature hard outlines, the results should look soft. It is easy to see when sharpening has gone too far when dark halos appear around contrasted features (Figure 4). When they appear, move the slider backwards until they vanish. Finally click on the square which has ‘select and process the whole image’ when the mouse is hovered above it (Figure 3). Once complete it is best to save the image as a 16-bit Tiff so as not to lose dynamic range.

![Image](image.png)

*Figure 3. The free ImPPG tool created by Filip Szczerek. Open a stacked image and choose the number of iterations and sigma for the Lucy Richardson deconvolution by using the small box on the image pane to gauge how much sharpening to apply, then select and process the whole image.*
Figure 4. The effects of sharpening in ImPPG a) original unsharpened stack; b) correct levels of sharpening applied; c) over-sharpened with halos around contrasted features.

When sharpening images in white light either ImPPG can be used or Smart Sharpen in Adobe Photoshop CS5 or version 6 works equally well. Open the stacked image in Photoshop and in the menu bar click on the ‘filter’ tab, use ‘sharpen - smart sharpen’. In the Smart Sharpen tool check ‘advanced’ and change the ‘remove’ tab to ‘lens blur’. Set the ‘amount’ to 400% and gently move the ‘radius’ slider to increase the pixels. Again stop when ringing occurs and move backwards until a natural smooth appearance to the granulation is given. Granulation should have a flat angular shape and not have a rounded raised appearance; this can be seen in Figure 5.

Sharpening can be achieved also using the popular cheaper version of Adobe Photoshop Elements by selecting the ‘enhance’ tab and ‘adjust sharpness’. Again check ‘more refined’ and set ‘remove’ to ‘lens blur’, amount to 400% and carefully adjust the radius. The same can be achieved very well in PixInsight, however in the freeware ‘Gimp’ there is less control as it is not possible to change the radius.

Figure 5. A demonstration of the Smart sharpen tool in Photoshop on granulation in white light a) original unsharpened stack from AutoStakkert12; b) using the Smart sharpen tool moderately to reveal granulation which has a flat angular appearance; c) applying the shadows/highlights tool to increase contrast in the granulation; d) the effects of over-sharpening showing loss of detail and bad ringing/halos.

Post processing

Post processing is in effect artwork; this will always be done to the particular taste of the individual and is unique. Some people prefer to keep their images black and white, whilst others prefer color. Some people prefer outrageous colors, others neutral tones. Some like high contrast and others low; so what follows below will be as a guide only and should be modified for your own taste. Also the
techniques will be described using Adobe Photoshop CS5 but they can all be done equally well and found in similar places in other software such as Adobe Photoshop Elements, PixInsight, GIMP, PaintShopPro and ImageJ.

Figure 6. Adding contrast to an image can cause important solar features to disappear from the image a) original sharpened image showing a sunspot with umbral dots; b) contrast added to improve definition of granulation and penumbral filaments to the cost of the umbral dots; c) umbral dots restored to the image by applying ‘shadows and highlights’.

Contrast, shadows and highlights

In the previous section of image capture we touched upon the problem of whether to use low gamma to force more contrast into the image or use high gamma to enhance the white details at the point of capture. It is generally not a good idea to do this because if small features are lost at this stage they can never be recovered. These details can be changed in post processing as long as the histogram was not clipped and data not lost at the point of capture. If capture was taken using a neutral gamma or a very slight decrease or increase then there is much more that can be done now to bring the image to the desired look.

There are several ways to increase contrast in Adobe Photoshop, the first is to go to the menu bar and click on the ‘Image’ tab and select ‘adjustments - exposure’. Here you will find the gamma correction control slider and it is possible to change the image to exactly as it would appear when viewing in the live camera mode. Alternatively, simply select the ‘Image’ tab and ‘adjustments - brightness and contrast’. The third and more advanced setting to adjust contrast is by using the ‘Image’ tab and ‘adjustments - curves’. This gives far greater control to the user and there are a few pre-sets which can be used for quick adjustments.

Great care must be taken when adding contrast to solar images. As stressed previously, the more unnatural contrast is added to the image, the more likely that the finer subtle solar features in dark regions, most notably in the umbra of sunspots will be lost. Figure 6 shows this effect with 6a the original image and 6b where contrast has been added. Note how 6b now lacks the umbral dots of the original, these are an important solar feature and now are lost. This is where the use of ‘shadows and highlights’ can be used as an important recovery tool. It too is found in the ‘Image’ tab ‘adjustments – shadows and highlights’ and using the pre-set settings Figure 6c shows a moderate recovery of the umbral dots whilst preserving the contrast. This same method can give added contrast to granulation as seen in Figure 5c.
‘Shadows and highlights’ is an essential tool for adding in low contrast features in prominences. If gamma is raised at point of capture this can enhance the low contrast prominence but will also reduce the overall black of the background to gray which can ultimately increase the likelihood of stacking artefacts to occur. Again it is far better to capture at neutral gamma or very slightly raised gamma then use ‘shadows and highlights’ in post processing instead. Figure 7a shows the original version of the prominence at point of capture and 7b the use of the pre-set values in ‘shadows and highlights’. Not only is the prominence enhanced but the background black is retained.

![Figure 7](image.png)

**Figure 7.** Using ‘shadows and highlights’ to reveal prominences a) original image at point of capture using a neutral camera gamma setting; b) one application of ‘shadows and highlights’ revealing the delicate filigree of the prominence while maintaining the black background.

**Color**

Color can be added to monochrome images very easily but it can be difficult to achieve the desired effect. To add color to the image it must first be changed from grayscale to RGB mode. Adobe Photoshop has a very simple tool found in the menu bar ‘Image’ tab ‘adjustments - variations’ and colour can be added by a series of increments to the desired look. However, to use this tool the image mode must be downgraded to 8-bit and there is no control over where the color is being
added to the image which can result in it quickly losing contrast. This can be rectified afterwards by use of ‘brightness and contrast’.

A second way of applying colors but in 16-bit mode, can be done using ‘Image’ then ‘adjustments - levels’. For an orange hue (Hydrogen alpha) first change the channel to red and in the central box add the value 1.7, then change the channel to green and add the value 0.6. Finally change the channel to blue and enter the value 0.2. Any of these values can be changed to suit and require trial and error. Again, brightness and contrast will need to be modified later.

Finally a third way of adding color in 16-bit mode allows the user more control over where the color is being added. This can be found in the ‘Image’ tab ‘adjustments - color balance’. Once the color balance tool is open check the ‘preserve luminosity’ box and pick where you wish to add colour, either in the shadows, the midtones or the highlights. To start, add colour to the midtones, then the shadows and highlights. This will allow far greater control to keep shadow areas more black and bright regions white whilst changing the color of the overall image. This tends to give richer tones and preserves the contrast levels.

The only caution with adding color to your image will be that it will highlight and enhance any noise present within the image.

Combining a surface and prominence layer

Very often when using a single stack etalon in Hydrogen alpha the dynamic range of the camera will not allow for a prominence and surface shot to be taken together within the same image. Either the prominence will be properly exposed and the surface burned out or the correct exposure for the surface results in the prominence not being visible. One way around this problem is to take two images of the same area within a minute of each other, one at the correct exposure for surface and one for the prominence. These can then be put together later in post processing.

First open both the surface image and the prominence image side by side and sharpen and post process each individual image separately as prominences generally require a different post processing routine compared to surface images. Prominences will not take kindly to as much sharpening as surface images as they will suffer from the effects of ringing much more quickly. Adding more contrast to a surface image is best done first as applying the same levels of contrast to a prominence will result in fine details being lost.

If the prominence image has been fairly over exposed to acquire very faint wisps of plasma then the surface of this image will almost certainly be pure white and will suffer from surface bloat. This is where the flare from the over exposed surface tends to make the surface of the Sun appear slightly larger than it really is. This can be rectified by increasing the size of the surface image. This takes trial and error as every image will be slightly different depending on exposure. Generally, increasing the size by 100.5% is about right when taking a full disc image of the Sun with a Coronado PST. In Adobe Photoshop this can be found in the ‘image’ tab and ‘image size’ and change the document size to ‘percent’. Whilst still working on the surface image activate the ‘magic wand’ tool and click on the black space region of the image. The marching ants will then be highlighting the entire surface of the solar disc. If this does not happen and areas are not completely covered (not a perfect circle) then adjust the tolerance of the magic wand tool either up or down and try again until a full smooth
outline of the Sun is established. Then go to the menu bar and click on the ‘select’ tab and choose ‘inverse’ to reverse the selection to the solar disc only. To soften the edge of your chosen selection and allow for better blending later, go to the ‘select’ tab again and ‘modify – smooth’. Pick a sample radius of 5 to start with (this can be changed if not enough or too much). Then ‘select – modify – feather’ and pick a feather radius of 5, again this can be changed to suit. Once this is complete change to the ‘move’ tool, left click in the highlighted surface region (some scissors should appear) and without letting go drag this region into the prominence image and let go. Now there will be two layers in the prominence image. Keep moving the surface image over the prominence image until it is finely matched to the right place. When happy that both fit together smoothly, flatten the image by going to the ‘layer’ tab and ‘flatten image’. This will bring the image back to a single layer again for saving.

Mosaics

A very common problem encountered when solar imaging is when a particular solar feature or the full solar disc will not fit entirely in the image frame of the camera. This is dependent entirely on the telescope equipment used and the size of the chip in the camera. Therefore it is necessary to take several images to cover the whole field of view and stitch them together in a mosaic later. There are a few programs that can do this and the most common are Adobe Photoshop Photomerge, AutoStitch, Microsoft ICE and iMerge; each available with tutorials online.

A successful mosaic is dependent upon many variables and what works on one occasion may not necessarily work on the next. What can be done is to work towards a method flow which should work most of the time. If imaging a full solar disc, first set the exposure and gamma to the correct amounts in the central portion of the solar disc so that no area is over exposed. The limb areas will be darker but that does not matter, it is essential that the exposure, gain and gamma is not altered during any part of the mosaic. Following this, it is essential that the seeing conditions in general are consistent and that there are no variable high clouds in the vicinity that will result in variable contrast and exposure during the acquisition of all the frames. The sky needs to be clear, and clear for the full duration of the capture. Variability between frames will result in a patchwork quilt effect. Unfortunately this is the same for seeing conditions, if seeing is highly variable then some frames will be less sharp than others, again giving the image a patchwork effect regarding detail. Another problem to consider, particularly when using a double stack Hydrogen alpha etalon is the non-uniformity of field. Many double stack solar filters will have dark bands or edges and brighter regions in the centre. This is more a problem with tilt tuned etalons rather than pressure tuned ones. To enable a seamless mosaic it is essential in this case to take a flat field image and process all the frames to be included with the flat to reduce the contrast variability. It is not necessary to take a flat field to match each image, just take one at the end of the sequence by moving the camera in to the centre of the solar disc (make sure the least amount of black space is visible) and take the flat using a translucent bag or cling film.
Figure 8. A method flow for taking images in a sequence around the solar disc for a mosaic. Always try to work in a zig zag motion so that each image in the mosaic is as close to each other as possible in time.

Figure 8 gives a guide in the direction to work around the solar disc. Try to work in a zig zag motion so that each image in the mosaic is as close to each other as possible in time. The solar features change quickly and there must be at least one frame that follows on from the next for the stitching software to function correctly. Instead, by working in a series of rows always from left to right, then a large period of time will have elapsed between frame one of row one and frame one of row two thus this will give poor stitching results. When moving through the frames make a mental note of prominent solar features and make sure at least one of these features is included in the next frame as a repeat. Be careful when moving downwards that the edge of the solar disc is included, it is very easy to miss a chip out in an intersection region.

When all of the frames have been acquired, process the flat field image, then load all the files into AutoStakkert12 and batch process using the flat. Once complete, assemble the images together using your preferred software. Adobe Photoshop CS achieves this using the Photomerge function found under the menu ‘File’ tab, then ‘automate – Photomerge’. Set the layout to ‘auto’ although you can add in ‘interactive layout’ by downloading the Photoshop plugins available on the Adobe Photoshop website. This ‘interactive layout’ can be essential if Photomerge cannot place a particular panel in ‘auto’ for some reason. In this mode the user can place the panels manually where they
should be. If in ‘auto’ check the ‘vignette removal’ box and browse and open all the files for the mosaic. It is not necessary to sharpen and post process all the panels first, it is best to do this after and altogether once the panels are assembled. When loaded click OK and wait for Photomerge to finish. When complete, set the background to black in the tool bar, click on the ‘layer’ tab and ‘merge layers’. Then ‘layer’ and select ‘new – layer from background’. Use the crop tool to neaten the edges and centralise the image and save as a 16-bit Tiff. Process this merged image by sharpening and post processing methods.

**Time lapse animations**

The Sun is a very dynamic object to observe and sometimes an event can happen literally before your very eyes. These real-time events can be quite spectacular in the case of a solar flare or a prominence lift off event and you will want to be able to capture it and have your very own movie. There are a few ways of doing this, either video the entire event with your camera and use specialist video editing software which will speed the video up, for instance an hour of video can be reduced to five or ten minutes of playback time. Or, take a sequence of short video captures, stack and post process each individual frame and put them together as a time lapse animation. The latter will give far better results by showing finer detail and a much quicker video.

To take a time lapse animation first choose a subject area in the desired wavelength. For Hydrogen alpha view the current time lapse solar animation on NSO GONG (National Solar Observatory - global oscillation network group) web page. Choose the current Sun marked in green and click on the movie reel to the right and watch carefully, find which prominence or active region is currently moving about the most and set this as your target through your telescope. For white light, choose any active region or even just a patch of granulation in the centre of the solar disc. Granulation can make a fascinating subject as the surface gradually changes over a period of five minutes creating a boiling appearance.

Once your target is selected and found in the camera, set the image scale that you wish to image at and centre the object in the field of view. In the FireCapture software check the ‘reticule’ box and pick a prominent feature and always keep it centred in the cross hair whilst taking the video series. This will be important later when aligning the sequence. Set the exposure and gamma and stick to this for the entire sequence. The skies must be clear for the duration of the time lapse similar to the rules in creating a mosaic image. If you have accurate alignment and tracking then FireCapture can be set to take a sequence of short video files at specific intervals for a given amount of time. Generally it is best to capture for no longer than 30 seconds or 500 frames and capture at one minute intervals. This can be shortened if the subject is moving extremely quickly but on average these settings will give a good result. If tracking is not so good, adjust your subject in the cross hairs and press record every minute manually readjusting tracking in between. Keep going for as short or long a time as you wish.

Once finished, the series of video files will be time stamped and thus in running time order (see Image capture section) this is important for file order. Run them through AutoStakkert!2 as a batch process, then sharpen in ImPPG as a batch process (this can be found under ‘File’ and ‘batch processing’). Before batch processing pick one file which is typical of all the stacked images and sharpen to taste, save these processing settings and use them in the batch processing tab.
Once all the images are sharpened, continue by post processing each individual image in the series. Try to keep post processing exactly the same in each image, this can be time consuming. Keep the starting frame open at all times and keep matching its appearance (especially brightness and contrast) for all the subsequent images. If using Adobe Photoshop this can be done quicker by recording an action for your post processing routine so that with one button click the image is post processed exactly the same each time in a matter of seconds.

Finally when all are processed it is time to align the images together for a smooth sequence. The most simple and best results are obtained using ImPPG but it can also be done in RegiStax 5. In the ImPPG software go to the ‘Tools’ tab and click on ‘align image sequence’. Add the files you wish to align, use sub-pixel alignment and crop to intersection. Generally ‘stabilize high-contrast features’ works well, if not use the ‘solar limb’ to align. Choose an output folder and start processing.

Once the images are processed and aligned together they are ready to be joined together to run as a time lapse sequence. Again there are many different software programs which will do this including Adobe Photoshop and GIMP. The process here will be described using Adobe Photoshop CS5.

![Adobe Photoshop CS5 animation window](image)

**Figure 9.** Adobe Photoshop CS5 animation window. Change to the ‘animation (frames)’ view by clicking on the bottom right corner of the window. To add all your frames to the animation click on the top right corner and choose ‘make frames from layers’. To finalise, change the bottom left tab to ‘forever’ and ensure all frames are set to 0 seconds. Press the play button and view your time lapse animation
Choose the ‘File’ tab and pick ‘Scripts – load files into stack’ and choose all the images for the time lapse. Each image frame will then be opened as a separate layer in the one image. For some reason Photoshop orders the files backwards in time but GIMP does not. If using Photoshop the frames need to be reordered first before proceeding or the time lapse will run backwards. Do this by choosing the ‘Select’ tab and ‘All Layers’, then the ‘Layer’ tab and ‘arrange – reverse’. Once complete, open the ‘animations’ window from the ‘Window’ tab. This window can be viewed either as ‘animation (timeline)’ or ‘animation (frames)’ the latter being easier (more simple) to master. Change to this layout by clicking on the bottom right corner (Figure 9). To add all your frames to the animation click on the top right corner (Figure 9) and choose ‘make frames from layers’. To finalise, change the bottom left tab to ‘forever’ and ensure all frames are set to 0 seconds. Press the play button and view your time lapse animation. To save this as an animated gif, go to the ‘file’ tab and choose ‘save for web and devices’. Generally the default settings are good however it can be a good idea to reduce the image size to 1000 pixels or less or the file can become quite large for posting on the web. Ensure the top check box is set as a GIF and save the file. This animated gif file can be uploaded on the web to any of the common file sharing sites; on Flickr the file will only run when viewing the ‘original’ size version of the image in the ‘sizes’ area of the photostream image. It is always a delight to view the finished result for the first time and even better to share it with others; it brings the Sun to life in a way that a still image never can.

**Imaging the Sun with a DSLR**

Only a few DSLR models seem to have been used successfully to image the Sun and it is very dependent on the software included in the camera. A few cameras which work well in solar imaging are the Canon 550D and the Canon 1000D, also the Canon T2i and the Panasonic GH2. What can make a difference can be purely model dependant as the Canon 1000D has a DIGIC III processor that works much better for white light imaging than the DIGIC IV in the 1100D.

When using a DSLR to image the Sun, switch to the monochrome mode and capture a video sequence. However, splitting off a single channel from the colour images in post processing can also work. Use VirtualDub software to convert the .mov files to .avi and processes and stack the frames in AutoStakkert!2 and post process as described above. It is possible to take a series of single images either JPEG or RAW and stack these in Autostakkert!2 as well but problems can arise if the image files start getting too large.

The biggest problem however with using a DSLR is achieving good focus; it can be hard to find the focus point using the live view of the camera. If the camera has a magnified live view use this to aid focus and the highlight priority mode to prevent saturation of bright features. Experiment with different exposures and ISO and eventually an optimum will be found for the different wavelengths of solar imaging.

**Web links**

FireCapture by Torsten Edelmann [http://www.firecapture.de/](http://www.firecapture.de/)

RegiStax by Cor Berrevoets  http://www.astronomie.be/registax/index.html

AviStack 2 by Michael Theusner  http://www.avistack.de/

ImPPG tool created by Filip Szczerek  https://greatattractor.github.io/imppg/

NSO GONG (National Solar Observatory - global oscillation network group)  http://halpha.nso.edu/